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1 Adlib Museum 

1.1 Changes in packages and locations 

In 4.4, the location and packag databases were merged into a single 
location database. This also meant that the 4.2 Packages and Loca-
tions data sources in Museum applications were merged into one Loca-

tions data source in 4.4, containing both locations and packages. In 
4.5 this data source has been renamed to Locations and containers. 
(Also, most “package” field labels have been replaced by “container” 
field labels, the latter being more generic.)  

Through the Location or container field you decide if you are going to 
enter a container or a location record. (Leave the field and the extra 

screen tab will appear.) 

 

 

In 4.4, the internal package hierarchy that was possible in 4.2 was 

replaced by the possibility to register a validated location (which can 
be an overpack as well) for the current package in the Current location 
box. 
In 4.5 though, packages (well, containers) are included in the 
hierarchy which already existed for locations, realized through internal 

links. For this purpose the function of tag t7 has been transferred to 
tag te (the name field) and the broader term link of the internal link 

for a container is now associated with tag bt (the part_of field) with 
link reference tag lb and the narrower term is associated with nt (the 
part field) with link reference tag ln, just like for a location. 
In a location record you can edit or view the nearby hierarchy in the Is 
part of and Includes part(s) screen fields on the Location details tab. 
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On the Container details tab on the other hand, the nearby hierarchy 
can be found in the (Current location) Name and (Contains) Name 
fields. 
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The complete hierarchy of a container or location can be viewed in the 

hierarchy browser which can be opened from within the detailed 

display, using F9. 

 

From within the object catalogues you can link to a location or con-

tainer record as usual, on the Location | Future movements tab, but 
the link no longer points to the barcode (tag vb) of locations and 
containers but to their name (tag te). Also new is that the upward 
hierarchy of the entered location or container will be displayed under-

neath the relevant location field, even on the Location history tab. 
That way you’ll know immediately where the object can be found. 

 

Conversely, existing links to object records can be viewed on the 

Linked objects tab in a package or location record. You cannot edit or 

add them here. 
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1.2 LIDO XML export format added 

To the Internal object catalogue and the External object catalogue in 

Museum applications 4.5, the LIDO export format has been added. 
The LIDO format can be used for delivering your object data to Euro-
peana, Deutsche Digitale Bibliothek, Museum Digital or some other 
cultural heritage portal. For more information about LIDO, see 
http://www.lido-schema.org.  
The relevant XSLT stylesheet could already be downloaded from our 
website, here, so you can easily set this export format up in older 

applications as well, using Adlib Designer (set the XML type property 
of the format to Grouped).  
From within Adlib, select one or more records in either dataset, click 

File > Export and select LIDO in the Export wizard to export the rec-
ords to a LIDO XML file. 

  

Before you apply the export format you’ll have to make two changes 

to the stylesheet first, to adjust the format to your situation. To do so, 
open the adlibXML2LIDO.xslt file (which can be found in the \xslt 

http://www.lido-schema.org/
http://www.adlibsoft.com/support/faqs/setting-up-the-lido-export-format-in-adlib
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subfolder of your Adlib system) in a suitable text editor, like 

Notepad++ or Visual Studio, and look up the template displayed 

below. De example URLs 

http://service.thecollectioncloud.com/wwwopacx/wwwopac.ashx

?command=getcontent&server=images&imageformat=jpg&value= 

and 
http://service.thecollectioncloud.com/wwwopacx/wwwopac.ashx

?command=getcontent&server=images&imageformat=jpg&width=100

&height=100&value= 

must then be replaced by URLs which have been set up in your 
system as the Retrieval path and Thumbnail retrieval path for the 
reproduction.reference field. In your application that field probably 
only contains the file name of the linked image, so that’s why you’ll 

have to provide the proper path or URL here in the stylesheet, to be 
pasted in front of the file name to be able to export the full URL. Note 

that here the URL must end with value= instead of value=%data%. 
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1.3 Reproductions for exhibition records 

To each record in the Exhibitions data source in 4.5, one or more 

images, movies or sound files can be linked on the new Reproductions 
tab. This allows you to register photos of the exhibition, for example. 
The reproduction.reference field (tag FN) links to the media database 
(previous called photo), like the reproduction.reference field in other 
databases links to media as well. 

 

1.4 Output formats for locations and containers 

◼ Bare and packaged objects by location 

A new output format has been added to the Location and containers 
data source, called Bare and packaged objects by location (BareAnd-

PackagedObjectsByLocation.ada/bin). It lists bare and packaged 

objects (not the packages themselves) per marked location record. All 

sub-locations of any marked location will be processed automatically, 
so it's best if your record selection doesn't include sub-locations of 
other marked locations. Of objects found at a sub-location of the 
marked location, or in a package, it won't be indicated that they were 

found in a package or at a sub-location: all objects present at the 
marked location(s), at its sub-locations or in packages, will be listed 
underneath each other in a single list. 
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◼ Bare objects and packages by location 

The 4.4 output format Objects and packages by location (ObjectsBy-

Location.ada/bin) has been renamed to Bare objects and packages 

by location (BareObjectsAndPackagesByLocation.ada/bin). It lists 

bare objects and packages per marked location.  

 

All sub-locations of any marked location will be processed 

automatically, so it's best that your record selection doesn't include 
sub-locations of other marked locations. The contents of packages 
(smaller packages and objects which have the overpack as their 
current location) won't be processed. Also, of objects and packages 
found at a sub-location of the marked location, it won't be indicated 
that they were found at a sub-location: all objects and packages 
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present at the marked locations or their sub-locations will be listed 

underneath each other in a single list. Since the contents of packages 

won't be processed, you should only mark locations in your record 
selection, not containers. 

◼ Full locations/packages/objects hierarchy 

The other 4.4 output format Full locations/packages/objects hierarchy 
(LocationToObjectHierarchy.ada/bin) has been changed some-

what. It now prints the full hierarchy from one or more marked loca-

tions or packages down to any smallest packages and/or (packed or 
unpacked) objects inside it. Of each location or package, the barcode 
number is printed behind the name. Package names are preceded by 
"P:", locations by “L:”. Of each object, the object name followed by 

the object number is printed, preceded by "O:". 
Note that it can take a long time for these output formats to finish if 

you have large databases: in that case it’s best to select no more than 
a single location and preferably not the top location. 
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◼ Objects moved today 

The ObjectsMovedToday.ada/bin is available in the \adapls folder of 

your Adlib 4.5 model application, but it hasn’t been set up to appear in 
the user interface of the application yet. If you need its functionality, 
you can set it up yourself as an Adapl command  type “data source” in 
the 4.5 application structure, using Adlib Designer. It will then appear 
in between the other data sources in Step 1 of the Search wizard (it is 
a stand-alone adapl so you shouldn’t set it up as an output format). 

It prints a list of all objects which have been moved today, regardless 
of their destination, even if those objects were “moved” to the same 
location, to a sub-location of their original location or to a location that 
was not registered in the object record. The key factor for inclusion of 

a record in the list is the presence of today's date in any of the 
Removal date field occurrences on the Location history tab of an 

object record.  
Of each object, the object name, number and title, will be printed. All 
objects will be grouped by their current location, but the locations 
won't be in alphabetical order. Moved objects which do not have a new 
current location, will be listed first. 

Due to a bug appearing in at least adlwin.exe 6.6.0.922 and 
7.1.13198.1, this adapl will function in these Adlib versions only when 

there is NO index present for ISO date field SE in Collect. However, 
since searching a non-indexed field requires a sequential search 
through all records, performance of this adapl on a large database will 

be bad, so in that case we recommend to use it for small databases 
only.  
To be able to use this adapl on a database of any size in model 
application 4.5 (which does have an index for ISO date field SE in 

Collect), Adlib version 7.1.13200.1 or higher is required. 

1.5 Entry and Despatch merged into Transport 

In 4.5, the 4.4 Entry and Despatch data sources (the datasets entry 
and despatch in transpor.inf) have been merged into a single 
Transport data source (dataset transport in transpor.inf), because on 
despatch within an organisation it isn’t always possible to make a 

strict distinction between entry and despatch/returns.  

In the new Transport data source you can still register both: in the 
Entry or despatch field you simply select the type of record you are 
currently describing. A Transport number will be created automatically 
from now on, so you won’t have to come up with one yourself.  
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For the transport status of each linked object, 4.5 offers a drop-down 
list to ease data entry. 
 

 
 
The little used Template for object data screen, to allow the immediate 
creation of basic records for linked objects in the External object 

catalogue, has been removed. 

On the General tab some new fields have been added, like Reference 
receipt, Reference transport papers, Notes type, Notes, Number of 

colli and Change location. As soon as you click the Change location 
checkbox and in the Destination field the new location for the linked 
objects has been filled in and an Entry date or Despatch date has been 
entered as well while the Date field (next to Change location) is still 
empty, the current location and the location history of the objects 
linked to this record will automatically be updated: you will still have 

to confirm this before the procedure really takes off.  
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1.6 Incoming and Outgoing loans improved 

To the Incoming loans and Outgoing loans data sources in Adlib model 

application 4.5, some significant improvements have been made. Be-
low we’ll only discuss the Incoming loans functionality for now: the 
Outgoing loans are more or less a mirroring of the Incoming loans. 
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◼ Loan request tab 

 

Enter at least an identifying number for this loan in the mandatory 

Loan number field. The number may also contain letters. 

The Lender field links to Persons and institutions and should contain 
the name of the organisation lending the incoming loan which you are 
describing in this record. Contact also links to Persons and institutions 
and may contain the name of the contact person at the lending organ-
isation; behind it, in the new Role field, you can enter the role of the 

contact in the organisation. 

In model application 4.5, the Status field has become a drop-down list 
with which you must set the status of this incoming loan manually. In 
model application 4.4, the loan status was determined automatically 
(by an adapl) and you could not manually change the resulting status. 

The Status date is set to today’s date during storage of the record: in 
a new record this happens unconditionally, while in an existing record 

this only happens when you’ve changed the status manually. A status 
change in an existing record automatically writes the previous status 
and previous status date to a new first occurrence of the Loan status 
history at the bottom of this tab. 
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The Period from and To fields in the Request details box are mandato-

ry and should contain the requested start and end date of the loan. 
The Duration in weeks will be calculated automatically after leaving 
either of both date fields, when both have been filled in. The Duration 
will be emptied if one of the dates is removed. The date fields will also 
appear read-only on the Contract tab, for comparison with the actual 
contract dates. 

To the (Request details) Reason drop-down list, two options have 
been added: permanent display and possible acquisition.  
Only if you select exhibition and leave the field, three extra fields ap-
pear below the Reason field, namely the Exhibition field in which you 
can link to an existing Exhibition record, after which the accompanying 
Start date and End date for that exhibition will be retrieved. 

 

To generate a ready-made Request letter (as a Word document) for 

the currently described loan, simply set the letter Template language, 
set the letter Date and click the checkbox behind the Template drop-
down list. The letter will be generated immediately and stored in the 
path indicated behind Dig.doc. The generated request letter, 
containing a standard request text and the list of requested objects, 
will also be opened automatically: you can edit the letter to your liking 

and save it, before actually printing and sending it. 
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When you’ve received confirmation of your request (not per se the 
approval), you can mark the Confirmed checkbox, enter the relevant 
date and link to the scanned document or copied e-mail in the 
Dig.doc. field behind it, via the Find file button in the ribbon. You can 
place the document you’ve received anywhere you like: the \Worddoc 
subfolder of your Adlib system doesn’t have a specific subfolder for 

such documents yet. 
Note that the Confirmed checkbox and date field are somewhat 
superfluous: typically you fill in both, except when you don’t know the 
date of confirmation. 

At the bottom of the Loan request tab, some fields for any internal 
actions to be planned for the incoming loan have been added. The 
Responsible person field links to Persons and institutions.  

The Loan status history fields are new as well and will be expanded 
automatically whenever you change the Status at the top of this tab 
and save the record. 

 

◼ Objects tab: 

 

The (Total) Insurance value, Handling fee, Insurance type en Insur-
ance company fields have been moved from the Objects tab to the 
Contract tab. 
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In the repeatable Objects field group on the current screen tab you 

link to objects in your own full Objects catalogue, which you’d like to 

request from the third party. That means you will have to register 
those foreign objects in that database first, before you can link to 
them here (you cannot force new object records from within the In-
coming loans). Typically you would create basic records for the re-
quested objects in your External object catalogue. (The reason that 
the Object number field here links to the entire Objects catalogue 

instead of just the External object catalogue is a technical one: if the 
objects you are currently requesting ever become part of your own 
collection permanently and you wish to move the relevant records 
from the External to the Internal object catalogue, then all links here 
in the loan record should remain intact, even if the loan record itself is 

no longer current.) The Object name, Creator and Title data will be 
merged in with the linked object, as well as the Insurance value and 

Currency registered in the object record. The reproduction reference 
link reference value is merged in as well, but the relevant image can-
not be displayed on screen because of software limitations: these ref-
erences are used to be able to print object images via some Word 
template output formats for the incoming loans.  
Note that the linked object number will be displayed in a distinctive 
colour to make it stand out: the colour doesn’t have any meaning. 

In the Status drop-down list you must enter a request status for this 
particular object and the date on which this status was determined. 

A Condition report drop-down list with accompanying checkbox, date 

and Dig. Doc field have been added in model application 4.5 to gener-
ate a condition report for the current object after it has been exam-
ined. Set the language for the report, set the report date and click the 

checkbox behind the drop-down list. The letter will be generated 
immediately and stored in the path indicated behind Dig.doc. The 
generated report, still unfinished, will also be opened automatically: 
you can edit the report to your liking (l.3 contains a default text and 
the text boxes below it are still empty) and save it, before actually 
printing it. 

The previously editable Insurance value and Currency fields have been 

made read-only since they are merged in with the object data, while 

the Handling fee field has been replaced by the Other costs field to 
which also a Notes field has been added. 

◼ Objects – compact list and procedures tab 

This is a new tab, containing the linked objects again, yet more com-
pactly displayed. You can link object records here or on the Objects 
tab. There are also three checkboxes which start an adapl procedure 
when you click them. 
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Exhibition: click the checkbox to synchronize all object links to an 
existing exhibition record now. On the conditions that in the current 
loans record a Loan number has been entered, the (Request details) 
Reason has been set to exhibition, an existing Exhibition has been 
linked, a Lender has been specified and at least one object has been 

linked, the procedure does the following three things (after your 

confirmation): 

• To records in the objects catalogue it adds a link to the exhibition, 
if the current loan Status of the relevant object in the list on this 
screen tab is either under discussion, approved, despatched, on 
loan, renewed or returned. 

• From records in the objects catalogue it removes any link to the 
exhibition, if the current loan Status of the relevant object in the 

list on this screen tab is either under consideration, refused, 
withdrawn or when the Status field is empty. 

• It reports on object records to which no link to an exhibition 

record has been added. 

Of course, when object records are updated with a link to an 
exhibition, the relevant exhibition record will reciproquely be updated 
with a link to the object record. 

Entry: click the checkbox to create a record in the Transport data 
source linking to all objects which are already linked to the current 
incoming loan record, and then link that transport record to the 
current incoming loan record. On the conditions that in the current 
loans record a Loan number has been entered, a Lender has been 
specified, no linked entry record is present on the Transport screen 

tab yet (the Despatch/Entry field, which is merged in with any linked 

transport record, must not read Entry), a Contact for the Lender has 
been filled in and at least one object has been linked, the procedure 
does the following (after your confirmation): 

• A new transport record will be written with the following data: 
Transport number = <automatically generated> 
Entry or Despatch = ‘Entry’ 
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Reason = ‘loan’ 

Destination = <your institution> (loans.txt line number 27) 

(Destination) Contact = (Lender) Contact from loan record 
Depositor = Lender from loan record 
Entry date = Contract period from from loan record 
(Input) Notes = ' Record created automatically from 
                          outgoing/incoming loans' (loans.txt line 
                          number 28) 

• To the new transport record links will be added to objects already 
linked to the loan record if the loan Status of the relevant object is 
either under consideration, under discussion, approved, 
despatched, on loan, renewed or returned. Then the Status of the 
relevant objects in the loan record will be set to despatched and 

the Transport number will be merged in from the new transport 
record. 

You’ll be notified of objects which haven’t been linked to the 
transport record and if there aren’t any objects with a relevant 
status at all. 

• You’ll be notified that the loan record must be saved in order to 
store the link to the new transport record. 

Despatch: click the checkbox to create a record in the Transport data 
source linking to all objects which are already linked to the current 

incoming loan record, and then link that transport record to the 
current incoming loan record. On the conditions that in the current 

loans record a Loan number has been entered, a Lender has been 
specified, a linked entry record is present on the Transport screen tab 
(the Despatch/Entry field, which is merged in with any linked 
transport record, must read Entry) while no despatch record may have 

been linked here yet, a Contact for the Lender has been filled in and at 
least one object has been linked, the procedure does the following 
(after your confirmation): 

• A new transport record will be written with the following data: 
Transport number = <automatically generated> 
Entry or Despatch = ‘Despatch’ 
Reason = ‘loan’ 

Destination = Lender from loan record 

(Destination) Contact = (Lender) Contact from loan record 
Depositor = <your institution> (loans.txt line number 27) 
Despatch date = (Contract period) To from loan record 
(Input) Notes = 'created from outgoing/incoming LOANS' 
                        (loans.txt line number 28) 

• To the new transport record links will be created to objects 

already linked to the loan record if the loan Status of the relevant 
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object is either under consideration, under discussion, approved, 

despatched, on loan, renewed or returned. Then the Status of the 

relevant objects in the loan record will be set to despatched and 
the Transport number will be merged in from the new transport 
record. 
You’ll be notified of objects which haven’t been linked to the 
transport record and if there aren’t any objects with a relevant 
status at all. 

• You’ll be notified that the loan record must be saved in order to 
store the link to the new transport record. 

◼ Contract tab 

The Immunity field has been added to the Contract details box. It 

allows you to register any indemnity details concerning the loan, 

which you and the lender have agreed about. In other words: any 
information about what should happen and who is responsible if ob-
jects on loan get damaged or stolen, etc. 

The physical contract itself, the original version and the returned, 
signed copy can be registered in the (Contract) Date and Signed & 
returned fields. You can store these documents anywhere you like 

before you link to them. 

A (Condition report) Template drop-down list with accompanying 
checkbox, Date and Dig. Doc field have been added in model applica-
tion 4.5 to generate a condition report for the loan as a whole (all 

linked objects together) after it has been examined. Typically you 
would choose between registering the condition here or registering the 
condition per object on the Objects tab. Set the language for the 

report, set the report Date and click the checkbox behind the drop-
down list. The letter will be generated immediately and stored in the 
path indicated behind Dig.doc. The generated report, still unfinished, 
will also be opened automatically: you can edit the report to your 
liking (l.3 contains a default text and the text boxes below it are still 
empty) and save it, before actually printing it 

 

In the Extension box (repeatable) you can create a standard letter to 

request a prolongation of the loan: select a New end date for the loan, 
a language for the letter and click the checkbox to create the letter. 
The result of the extension request can be registered here as well, in 
the Review fields.  
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The estimated and actual costs and hours fields from 4.4 have been 

replaced by a Costs and value box moved from the Objects tab to the 

Contract screen tab, with an automatically calculated total Insurance 
value and Other costs (based on the sum of the individual objects’ 
insurance values and other costs, except for the values of refused or 
withdrawn objects) and editable Loan fees and Handling fee, resulting 
in an automatically calculated Total costs. The total costs are 
calculated just before storage. The insurance value currency (behind 

the value) will only be filled in if the currency of the insurance value of 
all individual linked objects is the same, otherwise you’ll get an error 
message. 
The Total number of objects and the Total approved objects (linked 
objects with status approved, despatched, on loan, renewed or 

returned) are also indicated. 

 

◼ Transport tab 

The former Entry and Despatch tab has been renamed to Transport 
and the fields from both Entry details and Despatch details have been 

merged into a single field group. In Transport number you can link to 
a new or existing record in the Transport data source after which the 

read-only fields on this tab will be merged in. 

Note that 4.5 offers a quick way to generate a new transport record 
for the current loan and link to it, by clicking the Entry or Despatch 
checkbox on the Object – compact list and procedures tab, after 
you’ve linked all relevant objects to this loan. 

 

◼ Correspondence tab 

No changes on this tab. It lists any generated or received digital doc-
uments concerning this loan. Other related digital documents can still 
be registered here in the (Other correspondence) Digital document 
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field: link to an earlier saved document via the Find file button in the 

ribbon. 

◼ Reproductions tab 

A new Reproductions tab offers the possibility to link and view images 
of the incoming loan. Put the cursor in the Reference field and click 
the Import image button in the Edit menu in the ribbon to link to an 

image file. 

 

◼ Related loans tab 

No changes here. If there exist any other loans which have some rela-
tion to the current one, you can link to those loan records here in the 
Loan number field and indicate in your own words what the Relation 
type is. 

1.7 Other changes 

• The internal links in the 4.5 taxonom database (data source 
Taxonomy) have been based on link references, as was already 

the case for the other databases. Amongst others, this means that 
in the relevant fields, like the screen fields Parent name, Child 
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name, Valid/accepted name and Synonym, non-unique terms can 

be entered as well. The Scientific name must still be unique 

though. 

• The problem that in container records the merged-in fields with 
the Container type field (data dictionary field package_type, tag 
p2), namely the dimension type and dimension unit, were never 
displayed, has been solved in model application 4.5. 

• By default, the Archives (catalogue) data source now offers an 

EAD (Encoded Archival Description, version 2002, in UTF-8 
encoding) export format. 
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2 Adlib Library 

2.1 MARCXML export format added 

To the Library catalogue, Books, Audio-visual materials, Games, Arti-
cles, Serials, Loose-leafs, Cartography, Resources and Desiderata data 
sources in Library applications 4.5, the MARCXML export format has 

been added. In the international world of libraries, the MARC standard 
is an important standard for the exchange of bibliographical data be-
tween libraries. Adlib has always supported this standard, yet by link-
ing the MARC export format to the mentioned data sources it becomes 
easier for libraries to produce ad hoc MARC exports of any desired 

record selection. 

From within Adlib, select one or more records in one of the relevant 
datasets, click File > Export and select Export to MARC-XML format in 
the Export wizard to export the records to a MARC XML file. 

2.2 Other changes 

• The length of the shelf_mark (tag si) and copy.shelfmark (tag ey) 
fields in the document database definition has been enlarged from 
64 to 100 characters. The length of the index on si has been en-

larged to 100 characters as well. 
In copies.inf, the length of the corresponding tag ey and its index 

have been enlarged to 100 characters too. 

• The problem that titles forced from within an order record did not 
get an order status, has been solved in 4.5. Now, a forced title will 
automatically be assigned the order status “Will be ordered” as 
soon as the record has been saved.  
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3 Other applications 

3.1 All applications 

• All model applications 4.5 are based on the Adlib SQL database 
platform for Microsoft SQL Server. This means that for these 
applications the Adlib proprietary CBF database format will no 

longer be supported and you’ll always have to have some version 
of Microsoft SQL Server installed on your computer or company 
network. A free edition of SQL Server is also available from 
Microsoft: SQL Server Express. Our general installation guide 
Installing Museum, Library and Archive contains information about 

installing this platform. 

• On the Description tab in Persons and institutions, the (Digital 
references) Description and Reference fields have been added. The 
Reference field allows you to link to any desired file which you 
consider to be supplementary to the biographical details of the 
person described in this record. 

• The data dictionary name of the photo database structure has 
been changed to media (stored in the media.inf file), to emphasize 

its broader application. The name of the data source as it can be 
seen in the Adlib interface has been changed from Visual 
documentation to Multimedia documentation. 

If you are already using the Adlib Movement module and you are 
about to use model application 4.5, then in the AdmoveServer-
Setup.xml server configuration file you’ll have to replace the photo 
database name by media. The name change will probably have no 

consequences for an existing Internet Server web application. 

• To each record in the Persons and institutions and Thesaurus data 
source in 4.5, an image can be linked on the new Reproductions 
tab. This allows you to register passport photos, for example, or 
applicable images for a term. The reproduction.reference field (tag 
FN) links to the media database (previous called photo), like the 

reproduction.reference field in other databases links to media as 
well. 

http://www.adlibsoft.com/support/manuals/installation-guides/installation-of-adlib-museum-library-and-archive
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• Since long there’s been a so-called reciprocal relation between 
object records and media records: this allows you to view all 

linked media records (records of images of the object for example) 
in an object record and to view all linked objects in a media 
record. 
In model application 4.5, more of this type of reciprocal relations 
have been created, namely between media records and exhibition 

records, between media records and assessments and treatments 
records, between media records and package type records, 

between media records and person records and between media 
records and thesaurus records. Whether you create such relations 
in your records or not is entirely up to you of course.  
In a media record you can view or edit all linked records on the 
new Linked records – other tab or on the existing Linked objects 
tab. That way you’ll always know which links exist for a media 

record that you are editing or viewing. 
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